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Introducing Corel® VideoStudio® Pro X4

Corel® VideoStudio® Pro X4 tears down the
barriers to consumer video editing, offering a
robust feature set, outstanding speed, and simple
ways to quickly bring your video to life on-screen.
This high performance video-editing environment
combines an easy 3-step interface, a wealth of
intuitive creative effects, and an integrated
disc-burning and menu-authoring solution.

Simple steps to cinematic movies

With VideoStudio Pro X4, video editing is truly as
easy as 1-2-3. The clutter-free workspace is
uncomplicated enough for beginners and
powerful enough for tech-savvy video
enthusiasts. Simple steps speed you through the
basics, while an abundance of effects, menu
templates, sounds, titles, and transitions inspire
creativity.

The dedicated Capture step makes it a breeze to
get your media from DSLR cameras, DV and HDV"*
camcorders, and other mobile devices. In
addition, the Library lets you effortlessly organize
your photos, video clips, and audio files so you
can focus on the story you want to tell.

Your vision on any screen

You'll marvel at how quickly you can transform an
idea into a captivating movie. The straightforward
Timeline makes video composition fast and easy,
letting you add animated titles, practically
limitless creative effects, as well as background
music and voice-over audio.

(\:oiiléleoStudiOE')j(iz

The new Stop Motion tools introduce the fun of
animation — a perfect activity for the kid in
anyone, whether you're a parent looking for
family-oriented entertainment, a teacher with
designs on an exercise in cognizant learning, or a
teenager aiming to engross your online friends.
And with new Time-lapse effects, it's easy for
anyone to produce stunning scenes from
gradually developing events, like a setting sun or
moving clouds.

High performance video editing

Developed for the latest chips from Intel® and
AMD, VideoStudio Pro X4 ensures that you can
create without the wait. Plug-and-play support
for HD cameras and formats, like H.264 and
AVCHD", makes it effortless to access media —
no matter the device. And with Smart Proxy
editing, you can enjoy fast and responsive HD
video composition that won't tax your PC’s
resources.

Share and show anywhere

Ready to debut your film to the world? With
VideoStudio Pro X4, it's a cinch to screen your
movie with a diverse audience, whether viewers
will watch on iPhones or other mobile devices,
social media websites, game consoles, or disc
players and TVs. You can easily burn a DVD,
AVCHD, BD-J, or Blu-ray" disc, complete with
menu navigation. You can even burn 3D video
files to disc. What's more, VideoStudio Pro X4
offers presets for uploading directly to Facebook®,
Flickre, Vimeo®, and YouTube” — in SD, HD, and
even 3D.
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What's included?

Main application

Corel® VideoStudio® Pro X4: This high
performance video-editing environment
breaks down the barriers traditionally
associated with digital video by combining a
simple 3-step interface, a wealth of intuitive
creative effects, and an integrated disc-
burning and menu-authoring solution.

Supporting applications and content

DV-to-DVD Wizard: The DV-to-DVD Wizard
lets users capture video from a DV camcorder,
add a theme template to it, and then burn it
directly to DVD.

NewBlue®FX: A variety of NewBlueFX
animated effects are built right into
VideoStudio Pro X4 to help you customize
your video clips.

SmartSound®: \With integrated SmartSound
audio, you can easily built a fantastic
soundtrack, with sound effects, voice-overs,
and masterful mood music.

3D glasses

Minimum system requirements

Corel”

Microsoft® Windows® 7, Windows Vista®,
Windows® XP, with latest service packs
installed (32-bit or 64-bit editions)

Intel® Core” Duo 1.83 GHz, AMD Dual-Core
2.0 GHz or higher recommended

1 GB of RAM (2 GB or higher recommended)

[ Pro]

VideoStudio xa

128 MB VGA VRAM (256 MB or higher
recommended)

3 GB of free hard drive space
Minimum display resolution: 1024 x 768
Windows®-compatible sound card

Windows®-compatible DVD-ROM for
installation

Recordable Blu-ray” drive required for
creating Blu-ray discs

Internet connection required for online
features and video tutorials

Input/output device support

1394 FireWire® cards for use with DV/D8/HDV
camcorders

Support for OHCI Compliant IEEE-1394
USB Video Class (UVC) DV cameras

Analog capture cards for analog camcorders
(VFW and WDM support for Windows XP and
Broadcast Driver Architecture support for
Windows Vista and Windows 7)

Analog and digital TV capture devices
(Broadcast Driver Architecture support)

USB capture devices: Web cameras, and disc/
memory/hard drive camcorders

Windows-compatible Blu-ray, DVD-R/RW,
DVD+R/RW, DVD-RAM or CD-R/RW drive

Apple® iPhone”, iPad®, iPod classic® with
video, iPod touch®, Sony® PlayStation
Portable®, Pocket PC, smartphones
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Input format support

Video: AVI, MPEG-1, MPEG-2, AVCHD",
MPEG-4, H.264, BDMV, DV, HDV", DivX®,
QuickTime®, RealVideo®, Windows Media®
Format, MOD (JVC® MOD File Format), M2TS,
M2T, TOD, 3GPP, 3GPP2

Audio: Dolby® Digital Stereo, Dolby® Digital
5.1, MP3, MPA, WAV, QuickTime, Windows
Media® Audio

Images: BMP, CLP, CUR, EPS, FAX, FPX, GIF,
ICO, IFF, IMG, J2K, JP2, JPC, JPG, PCD, PCT,
PCX, PIC, PNG, PSD, PSPImage, PXR, RAS,
RAW, SCT, SHG, TGA, TIF, UFO, UFP, WMF

Disc: DVD, Video CD (VCD), Super Video CD
(SVCD)

Output format support

Video: AVI, MPEG-2, AVCHD, MPEG-4,
H.264, BDMV, HDV, QuickTime, RealVideo,
Windows Media Format, 3GPP, 3GPP2, FLV

Audio: Dolby Digital Stereo, Dolby Digital
5.1, MPA, WAV, QuickTime, Windows Media
Audio, Ogg Vorbis

Images: BMP, JPG

Disc: DVD (DVD-Video/DVD-VR/AVCHD),
Blu-ray Disc” (BDMV)

Media: CD-R/RW DVD-R/RW, DVD+R/RW,
DVD-R Dual Layer, DVD+R Double Layer,
BD-R/RE
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Key features

While developing VideoStudio Pro X4, we've
focused on four key areas that our customers
identified as critical for a video editor:

* simple steps to cinematic movies,
* your vision on any screen,
* high performance video editing,

* and share and show anywhere.

Simple steps to cinematic movies

VideoStudio Pro X4 provides a simple, quick, and
straightforward way to turn your video clips into a
movie. The clear-cut workspace is suitable for video
editors of all skill levels and presents three easy
steps: 1-Capture, 2-Edit, and 3-Share.

The Capture step gives you easy ways to capture
or load media, the Edit step offers a wide variety
of video-editing options, and the Share step
presents all the output options you need to reach
your audience. By combining a wealth of features
and effects with outstanding performance and
stability, VideoStudio Pro X4 offers an enjoyable
user experience that's fun for the whole family.

New! Flexible workspace: VideoStudio Pro X4
gives you the control and flexibility to set up your
workspace any way you want. With new grab
bars across the top of all three panels in each tab,
you can undock any panel by simply dragging or
double-clicking it. You can easily resize undocked
panels and distribute panels across two monitors,
which lets you maximize the Preview Window,
Project Timeline, and Library screens.
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You can distribute the VideoStudio Pro X4 workspace panels across two monitors.
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Easy video discovery: \Whether your video is
from a webcam, DV tape, computer, or mobile
device, VideoStudio Pro X4 continues to offer
easy ways to get video files from your camera or
other device. The dedicated Capture step gives
you all the options you need to unearth your
stockpile of digital memories. You simply connect
a device, choose an option, and then you're ready
to start editing your video.

New! Library ease of use: VideoStudio Pro X4
offers a versatile and simple project management
model. The Library is the focal point of any video
editing project. Once you've captured your video,
you need a repository to sort and select the clips to
use in your movie. The Library lets you organize and
sort a variety of media, including audio clips, filters,
graphics, photos, transitions, and video clips.

With VideoStudio Pro X4, the Library makes it
even easier to find precisely what you need. There
are new icons that let you show or hide video
clips, photos, and audio clips, limiting or
expanding contents as you search for the right
movie element. A new Browse button opens
Windows Explorer to help you locate media and
drag it to the Library.

You can also show or hide the Navigation panel
for an expanded view of all available media,
choose between a list or thumbnail view, and sort
media by name, type of date added. What's
more, you can easily create custom project-
specific libraries, which lets you work on multiple
projects without muddling your source content.

Give it a try

To create and populate a custom library

1 Click the Edit step, click the Add
button in the Library Navigation panel, and
type a name for your custom library.

2 Click the Browse & button, navigate to the
folder containing the media that you want to
use, and drag content from Windows Explorer
into the Library panel.
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New! Template import / export: \With
VideoStudio Pro X4, you can now import
templates and export your projects as Instant
Project templates. This can help you create a
consistent style for your video projects and lets
you share templates with other video enthusiasts.
Movie templates offer shortcuts to cinematic
styling, complete with credits, titles, pan and
zooms, soundtracks, and more.

With the Corel® Guide, you can access freely
downloadable media packs, including a variety of
templates, titles, fonts, as well as additional
creative and editing tools.

You can create and share templates
with Instant Project.

Give it a try

To create an Instant Project template

Imagine that you run a used guitar shop and
have a video blog for showcasing new arrivals.

You will want your videos to appear
professional and consistent, which is a perfect
time to use Instant Project templates.

You can easily create a template with a title
screen, audio track overlay, and placeholder for
a brief text description.

Then, you can quickly produce videos with a
similar look and feel whenever you add a new
guitar.

1 Open the video project that you want to save as
a template.

2 Click File » Export as template, and click Yes
when prompted to save your project.

orel®
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Give it a try

3 In the Save As dialog box, type a name for
your template in the File name box.
You can include more information to help
recognize your template by adding a Subject
and Description.

4 Click Save.

5 In the Export project as template dialog
box, move the slider to choose a thumbnail to
use for the template, review the path and
folder name, and click OK.

You can now share your template with other
users, who can import it as an Instant Project.

New & Enhanced! Corel® Guide: This unique
resource offers an array of useful information,
online Help, product updates, add-ons, freely
downloadable media packs, additional paid
content, and training videos. The Learn tab
provides 24-7 access to the application’s online
Help and to proficiency-building videos from the
CorelVideo channel on Vimeo. The Do More tab
presents a collection of downloadable templates,
titles, fonts, creative effects, and editing tools.

#¥:Corel® Guide

The Corel Guide provides access to additional
templates and content.

Corel”
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Give it a try

To access video tutorials

1 In the upper-right corner of the application
window, click the Help and product

information button.

2 In the Corel Guide, click the Learn tab.

You are now connected to the CorelVideo
channel on Vimeo.

Use the navigation slider on the right to scroll
through the available videos, and click to
choose a video.

Single Clip Trim: Trimming video is one of the
top motivators for consumers seeking video-
editing software. Many people are simply keen to
upload a piece of their video footage to Facebook
or Youtube for sharing. To that end, VideoStudio
delivers quick and easy ways to split and trim
video with both Single Clip Trim and Multi-trim
Video options.

The Single Clip Trim dialog box makes it easy to
frame and accurately trim single clips. You can
access the dialog box by double-clicking any clip
in the Library.

You can quickly and easily trim video clips.

Give it a try

To trim a single clip
1 Double-click any clip in the Library.
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Give it a try

2 In the Single Clip Trim dialog box, use the
Jog Wheel to select a starting point,
and click the Mark-in Il button (or press F2).

3 Select an endpoint, and click the Mark-out 1]
button (or press F3).

4 To preview the result, click Play B (or press
the Spacebar).

When you are satisfied with the result, click OK.

Multi-trim Video: With the Multi-trim feature,
you can easily extract multiple segments from any
video clip. The AccuCut timeline makes it fast and
simple to zoom in precisely on the exact frame
that needs to be trimmed. You simply play the
video, click the Mark-in button to set the start
point for the trimmed clip, click the Mark-out
button to set the end point, and then repeat. The
trimmed clips appear in the Timeline, where you
can delete or re-adjust clips.

The Multi-trim Video dialog box includes a Jog
Wheel for quickly scrolling through video and a
Shuttle slider for easily finding exact frames. Plus,
the Ad-Zapper automatically detects commercials
in videos captured from TV, allowing for easy
removal.

New! NewBlue® live preview: A variety of
NewBlueFX animated effects are built right into
VideoStudio Pro X4 to help you customize your
video clips. The NewBlue effects now provide a
live preview in the VideoStudio Preview Window
so that you can see the affect of a filter in real
time. VideoStudio Pro X4 continues to provide
exclusive NewBlueFX filters, such as the Picture-
in-Picture Animator that lets you bring motion to
any picture-in-picture window with rotations,
angle, 3D effects, and more. These filters give you
plenty of creative options to produce all kinds of
interesting video effects, such as movie intros,
title screens, menus, and much more.

Other notable NewBlueFX filters include

* the Detail Enhancer for strengthening edges
and bringing out detail in a dull or foggy scene,

* and the Active Camera for simulating camera
jitter.
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The NewBlueFX dialog box now provides a live preview.

Give it a try

To create a picture-in-picture effect

1 Drag a video clip to the Video Track in the
Timeline.

2 Drag a video clip to the Overlay Track in the
Timeline.

3 Click Settings » Preferences, click the Edit
tab, and enable the Use Fit-to-Screen as
default size in Overlay Track checkbox.

4 In the Library Navigation panel, click the Fx [&
icon and drag the Picture-in-Picture filter
onto the overlay track.

5 Click the Options button, click the
Attributes tab, and then click Mask &
Chroma Key.

6 Enable the Apply Chroma Key checkbox,
choose Mask Frame from the Type drop-
menu, and then choose a mask frame.

You can watch the Preview Window to see the
effect of the mask on the overlay.

7 In the Timeline, click to select the overlay track,
then click the Attribute tab and click the

Customize Filter & button.
8 In the NewBlue Picture-in-Picture dialog

box, click one of the keyframe icons to choose an
animation style for the overlay, and then click OK.

Corel®
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Your vision on any screen

Traditionally, video-editing developers have
followed an everything-but-the-kitchen-sink
approach in which feature counts, hardware
optimization, and technical jargon dominate.
While balancing the need for speed and power
under the hood, VideoStudio Pro X4
differentiates itself with a primary mandate of
simplicity. The clutter-free workspace makes it
easy for anyone to take an idea for a video and
watch it come to life on-screen.

You'll be amazed at how quickly you can realize
your vision — with all the exciting effects and
embellishments that pros use. And whether your
intended viewers will watch on a mobile device, a
TV at home, or any screen connected to the
internet, VideoStudio Pro X4 makes it easier than
ever to reach your audience.

FHAII 00T

New! Titles in overlay tracks: For consumers
dabbling in movie production, the placement of
text over video is a popular effect. You want to
give your film a professional touch, with
animated text that introduces a wedding video,
adds descriptive context to a scene in a
documentary, or gives credit to the production
crew.

With VideoStudio Pro X4, you can now place
titles in any overlay track, which means that you
can position animated titles behind other on-
screen objects. This gives you more creative
flexibility to add depth and drama to your video
projects. You simply drag a title style from the
Library to any overlay track in the Timeline. You
can even add titles to the main video track, and
add transitions at the beginning or end of a
single clip. VideoStudio Pro X4 offers 27 filters
specifically for enhancing titles and 64 fonts to
help you achieve just the right look for your
movies.

You can add multiple titles to overlay tracks that give greater depth and drama to your video projects.

v(ilaeoStudioJ)i(iz
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Give it a try

To add multiple titles to an overlay track

1 Drag a video clip to the Video Track in the
Timeline.

2 Right-click the Overlay Track in the Timeline,
and choose Track Manager from the drop-
menu.

3 In the Track Manager dialog box, enable the
checkboxes for Overlay Track #2 and
Overlay Track #3, and click OK.

4 In the Video Track, click to select the clip,
press Ctrl + C, and then click in the first
Overlay Track.

The copied clip appears in the Overlay Track.

5 In the Library Navigation panel, click FX Ed and
drag Picture-in-Picture onto the overlay clip.

In the Preview Window, use the handles to
adjust the size and position of the picture-in-
picture overlay.

6 Click Options IEEZEES click the Attributes

tab, click Mask & Chroma Key E, and then
enable the Apply Overlay Options checkbox.

7 Press Ctrl + C to copy the overlay clip, and
then click in the third Overlay Track.

In the Preview Window, use the handles to
adjust the size and position of the picture-in-
picture overlay.

You can position this overlay at a different time
interval than the original video.
8 Click to select the first Overlay Track, click the

Title M icon in the Library Navigation panel,
and then double-click in the Preview Window
to type a title.

For example, Title #1.

9 Click the third Overlay Track and double-click
in the Preview Window to type a title.

For example, Title #2.

Press Play > B preview the effects.

[ 10 ] Reviewer's Guide

Multi-track overlay effects: You can apply
filters on overlay tracks for video and graphics,
which allows for easy compositing when editing
your video productions. You can even apply filters
on top of other filters to create unique and
surprising effects.

Replace Clip: VideoStudio Pro X4 simplifies
replacing a single video clip within a production
— without altering the rest of the video. By
simply pressing the Ctrl key while dragging a
new clip to the Video Track, the Replace Clip
option modifies the new segment to be exactly
the same length as the one it's replacing. You can
also swap out a video clip for a photo or a color
clip and replace audio clips.

Give it a try

To replace a cli

1 Drag a video clip to the Video Track in the
Timeline.

2 Drag another video clip directly over the first
clip in the Video Track.

3 Hold down Ctrl as you release the left-mouse
button.

The new clip will be resized to the length of the
clip it's replacing.

orel® I Pro|
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New! Stop Motion animation: \With the new
Stop Motion animation tools, VideoStudio Pro X4
introduces the fun of giving life to inanimate
objects. This classic animation technique is an
absolute riot for anyone interested in filmmaking,
and has produced renowned films and television
shows, such as Wallace & Gromit, and Gumby.

For parents and kids, stop-motion is a fantastic
way to while away the hours on a rainy
afternoon. For teachers and students, it's a great
multifaceted learning opportunity. In addition to
endless amusement, you'll exercise creativity,
story telling, orderly thought, project planning,

Sop Motonll

00:00:01.00

00:00:02.10

patience, and much more. And you can choose to
animate just about anything, like clay or putty,
building blocks, figurines, and other toys.

VideoStudio Pro X4 lets you capture images from
webcams, DV and HDV camcorders, and you can
also import images from a DSLR camera. When
capturing images, the Stop Motion window lets you
choose the exposure time for each image, adjust
capture resolution, or use Auto Capture to set
automatic time increments. In addition, the Onion
Skin feature lets you control the opacity of the new
captured image and the previous captured frame.

10 frames
1260 % 1024

1 e

00 0 oo 00:00:04.00

The new Stop Motion tools offer endless fun and creative expression.

Give it a try

To create a manual stop-motion_
animation

1 With a webcam connected to your PC, click
the Capture step, and then click
Stop Motion B

2 In the Stop Motion interface, type a name in
the Project Name box.

Corel”
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Give it a try

3 Choose the exposure time for each image from
the Image Duration drop-menu.
A higher frame rate results in a shorter
exposure time for each image.

4 Adjust the Onion Skin slider from left to right
to control the opacity of the new captured
image and the previous captured frame.

5 Click Save.
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New! Time-lapse / strobe effect: You can
easily create cool time-lapse or strobe effects
from a series of photos with VideoStudio Pro X4.
Time-lapse photography involves capturing a
series of consecutive photos of a gradually
occurring event, like moving traffic, a rising tide,
or a setting sun. For example, you might set a
camera to shoot an evening skyline every few
seconds over the course of 8 hours.

With VideoStudio Pro X4, you can import the
series of photos and specify how many photos to
keep, how many to discard, and the duration of
each frame in the resultant clip. You can also use
this effect on video clips.

How Time-lapse works;
Ex. Keep 1 frame, Drop: 2 framesz, Frame duration: 1 frame

If the frame duration iz over 1 frame, Strobe effect will be produced.

Preview

Keep: = frame(s)
Drop: 1] = frame(s)
Frame duration: 0 =0 =0 =1 | B (H:MS:H
Total duration: 00:00:01.11
[ (] 8 ] | Cancel |

You can create time-lapse or strobe
effects from a series of photos.
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Give it a try

To apply a time-lapse effect to photos

1 Click File » Insert Media File to Timeline »
Insert Photo for Time-lapse/Strobe.

2 Navigate to the folder containing the photos
for the project, select them, and click Open.
For best results, choose a series of photos taken
in succession from your DSLR.

3 In the Time-lapse/Strobe dialog box, press

Play (s to preview the clip created from
your series of photos.

4 |In the Keep box, specify the number of frames
to retain for your clip.
A video frame is created for each photo in the
series.

5 In the Drop box, specify the number of photos
that you do not want to include in the final
video clip.

This will create a rhythm for the time-lapse
effect. For example, you might keep one photo
and drop two, which will be repeated to
produce the time-lapse clip.

6 In the Frame duration box, specify the
exposure time for each frame.
If the Frame duration is more than 1 and
Total duration is shortened, you'll get a time-
lapse effect.

7 Press Play s to preview the effect, and
click OK when you are satisfied with the result.

New! FX Fade: With VideoStudio Pro X4, you
can now fade-in or fade-out of certain effects.
This is useful, for example, if you want a picture-
in-picture window to appear or disappear
gradually. When an effect is eligible for fading,
Fade buttons will be accessible from the Options
panel. Alternatively, the right-click menu will
present Fade-in and Fade-out options for eligible
effects.

orel®
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With some effects, you can fade-in or fade-out to create a stylish transition.

Give it a try

To apply FX Fade on a clip

1 Drag a video clip to the Video Track in the
Timeline.

2 Right-click the clip, choose Copy from the
drop-menu, and then click to position the clip
at the 2 second mark in the Overlay Track.

3 Position your cursor toward the end of the
overlay clip and drag to shorten the clip by 2
seconds.

4 In the Library Navigation panel, click the FX &
icon, and drag AutoSketch to the clip in the
Overlay Track.

5 Click the Options button, click the
Attributes tab, click the Fade In Bl button,

and then click the Fade Out M button.
Note: You can also apply FX Fade by clicking

Customize Filter B, and then setting the
fade-in and fade-out points in the dialog box.

6 Drag the Scrubber & to the start of the video
and press Play B o see the result.

(\:olrirdeoStudioJ)j(zz

Enhanced! SmartSound® multi-layer
music: A great soundtrack is crucial for any
movie. With VideoStudio Pro X4, you can easily
add sound effects, voice-overs, and masterful
mood music with SmartSound. Multi-layered
audio tracks from SmartSound let you fine-tune
individual instruments, which gives you an
incredible range of possibilities to complement
your movie with mood music.

An enhanced real time preview makes it easier
than ever to customize your soundtrack. And you
can now access the SmartSound dialog box
directly from the Timeline toolbar. In addition, the
Corel Guide provides more music options from
royalty-free website Jamendo.

Mood Properties

vood: [ v |
Percussion E —
Bass 37
Synth Kalimba 73—
Guitar, Lead Synth —J—
[JAdd to Timeline

With SmartSound multi-layer music, you can adjust
instrument levels to achieve masterful mood music.
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Give it a try

To adjust individual instruments in an
audio track

1 Click the Edit step, and click the Auto
Music B2 button on the Timeline toolbar.

2 In the Auto Music tab, choose Music Multi-
layer from the Scope drop-menu.

3 Choose Album from the Filter drop-menu.

4 Choose any asterisked title from the Music
drop-menu, and click Set Mood EA.

5 In the Mood Properties dialog box, adjust
any of the instrument sliders.

You can preview your adjustments by using the
Play &4 and Stop & buttons.

6 When you are satisfied with the result, enable
the Add to Timeline checkbox, and click OK.

RotoSketch: The principles of rotoscoping —
tracing over live-action film movement to create
animation — are the foundation of RotoSketch.
By simply applying a GPU-optimized filter, videos
can be turned into realistic animated clips.

You can trace over live-action movement to
create realistic animated video clips.

[ 14 ] Reviewer's Guide

Give it a try

To create a RotoSketch from a video clip

1 Click the Edit step, click the Media
icon in the Library Navigation panel, and then
drag a video clip to the Video Track in the
Timeline.

2 In the Library Navigation panel, click the Filter

B3 icon, and then drag the RotoSketch filter
onto the clip in the Video Track.

3 In the Preview Window, click Play B 0 see the
sketch of the video clip.

Painting Creator: \With the Painting Creator,
you can record painted, drawn, or written strokes
as an animation to use as an overlay effect. For
example, you can enhance a family vacation video
by drawing your route on a map and overlaying it
on the video. The Painting Creator lets you choose
to create still paintings or animations.

Pt Congiin | Arimptnge st W5 » 280 |

The Painting Creator lets you add personalized overlay
effects, such as a particular route over a map.
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High performance video editing

By integrating the latest hardware innovations,
VideoStudio Pro X4 continues to eliminate the
technical hurdles traditionally associated with
digital video editing. Where you once needed
specialized knowledge to capture digital video to
a video card, VideoStudio Pro X4 offers support
for plug-and-play HD cameras. Where rendering
to DVD once involved hours and hours of waiting,
VideoStudio Pro X4 is built for today’s fast
multicore processors and GPUs.

New! Processor optimization: \VideoStudio
Pro X4 has been optimized for the new second
generation Intel® Core and AMD Fusion”
processors. These powerful processors deliver
both CPU and GPU capabilities in a single
processor, which is perfect for data-heavy HD and
3D video workloads. The result is a video-editing
application that’s built for speed and
responsiveness.

Note: For maximum performance from the latest
available chipsets, a product update may be
required after installation. You simply launch the
Corel Guide, click the Home tab, and then click
Check for updates to ensure that you are

up-to-date with the latest product enhancements.

HD import: It started on TVs, soon found its way
onto computer screens, and today it's on phones,
media players, and other mobile devices. As HD
continues its expansion from novelty to ubiquity,
VideoStudio Pro X4 ensures that you can keep
pace. Whether you're capturing H.264 or AVCHD
from a phone, compact camcorder, or HDV
camera, VideoStudio Pro X4 provides support for
a wide range of HD cameras and formats.

Smart Proxy: By using lower-resolution proxy
files for editing and previewing an HD project,
VideoStudio Pro X4 requires fewer system
resources, which results in faster, smoother
editing of HD video. The proxy video is used only
for editing. When it's exported, the proxy clip
links back to the original HD video, so the final
product is full HD quality.
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HD authoring and burning: With its new
integrated burning functionality, VideoStudio Pro X4
makes it easier than ever to author HD movies to
DVD and Blu-ray Disc.

Support for H.264 compression: H.264, the
cutting-edge video-compression technology in
the MPEG-4 standard, offers the best of both
worlds — incredible video quality from the
smallest amount of video data. With VideoStudio
Pro X4, you can take advantage of H.264
compression when saving an HD MP4 file. The
result is a stunningly crisp, vivid movie in a much
smaller file size. This saves bandwidth and makes
it easier to share your HD projects to a variety of
devices ranging from low-powered cell phones to
high-powered Blu-ray devices.
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Share and show anywhere

After you've poured your creativity into
moviemaking, you'll want to showcase your video
for an audience. With VideoStudio Pro X4, you
have an array of options that help you connect
with viewers — no matter the medium. You can
burn a DVD, AVCHD, BD-J, or Blu-ray disc, export
specifically for a variety of mobile devices or game
consoles, and upload directly to Facebook, Flickr,
Vimeo, or YouTube.

Enhanced! Create Disc: VideoStudio Pro X4
now provides integrated disc authoring
functionality that lets you create advanced DVD,
AVCHD, Blu-ray, and BD-J discs from your video-
editing projects. You can choose from 39
customizable menu templates to give your discs a
personalized, professional appearance.

The intuitive features make it easy to add
chapters, decorations, music, and titles to your
disc’s navigation menu. You can even add GIF
animations, graphics, or photos. A preview
windows lets you see exactly what your audience
will see as you design your menus. By integrating
a disc burning and menu authoring wizard,
VideoStudio Pro X4 reduces the steps needed to
share your projects on disc.
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You can create professional-looking menus with the
new, integrated disc authoring functionality.
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Give it a try

To create an AVCHD™ disc with menu
navigation

1 Click the Share step, click Create Disc
ﬂ, and choose AVCHD from the drop-down.

2 In the Corel VideoStudio Pro disc burning
window, ensure that the Create Menu
checkbox is enabled, and click Next.

3 In the Gallery tab, click an icon to choose a
menu template.
Click the Edit tab to adjust the settings for
background music and imagery.

4 In the Preview Window, click on any of the
current menu text to edit it, and click Font

Settings o adjust the style of the text.

You can also click on the various menu
elements to reposition or resize them.

5 Click Next, and then click Burn Ed.

Enhanced! Web sharing: The web is your
expressway to connect with an audience. When
you're ready to share your video, you can choose
from several output options that are specifically
optimized for the web. VideoStudio Pro X4 provides
presets for uploading directly to YouTube, Vimeo,
Facebook, and Flickr in both HD and SD formats.

Sharing to Vimeo®: \With a focus on user-
created, high-quality videos, Vimeo is a natural
place to share your video productions. To that
end, you can upload projects to Vimeo directly
from VideoStudio Pro X4 in both SD and HD.
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You can upload video files to Vimeo directly from
within VideoStudio Pro X4.
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Give it a try

To upload to Vimeo®

1 Click File » Open Project, navigate to the
folder containing the video that you want to
share, click to select it, and then click Open.

2 Click the Share step, click Upload

to Web , and choose one of the following
options from the drop-menu:

e MPEG-4 HD (16:9)

e MPEG-4 (4:3)

3 In the Create Video File dialog box, click
Save.

4 If you're already a Vimeo member, type your
Username and Password, and click Next.
If you're new to Vimeo, click Join Vimeo and
follow the instructions to create an account.

New! 3D export: \With VideoStudio Pro X4, you
can easily convert 2D video clips into 3D files. In
the Share step, you simply click Create Video,
and then choose the appropriate 3D preset. There
are presets for 3D output on DVD, Blu-ray, and
AVCHD discs, as well as WMV 3D formats suitable
for mobile devices.

New! 3D export to YouTube™: The new
YouTube 3D output option lets you quickly and
easily convert a 2D video into 3D and upload it
directly to YouTube.

Enhanced! Smart Package: The newly
integrated WinZip® technology provides
additional compression and encryption options
for Smart Package. Invaluable for students,
collaborators, or anyone wanting the freedom to
create movies on multiple PCs, Smart Package
gathers all video, photo, and audio files used in a
project into one folder. With VideoStudio Pro X4,
Smart Package now offers multiple compression
options, a best method for each file type, and
presets for CD, DVD, or Fat32 file systems. What's
more, you can also choose a custom compression
method and secure your Smart Package with
password encryption.
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Pack as:

() Falder

Falder path:
zhiansiDocumentziCorel YideoStudio Protky Projects E]

Project folder name:

K.apaking excursion

Project file name:

K.apaking excursion

Total files: 5
22223KB
446,492 KB

Froject file version: 14.00

Total size:

Dizk space available:
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With Smart Package and integrated WinZip
technology, you can easily package, compress,
and encrypt video projects.

Give it a try

To create a Smart Package
1 Click File » Smart Package.

2 In the Smart Package dialog box, enable the
Zip file option.

3 In the Folder path area, click the Browse
button, navigate to the drive where you want
to save the project, and click OK.

4 Click OK to start the compression process.

5 In the Zip project package dialog box, click
Change Compression, choose one of the
available presets, and then press OK.

6 In the Split Zip File area, choose Do Not
Split, and click OK.
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About Corel

Corel is one of the world’s top software companies, with more than 100 million active users in over 75
countries. We develop software that helps people express their ideas and share their stories in more
exciting, creative, and persuasive ways. Through the years, we've built a reputation for delivering innovative,
trusted products that are easy to learn and use, helping people achieve new levels of productivity. The
industry has responded with hundreds of awards for software innovation, design, and value.

Our award-winning product portfolio includes some of the world’s most widely recognized and popular
software brands, including CoreDRAW® Graphics Suite, Corel® Painter”, Corel DESIGNER® Technical Suite,
Corel® PaintShop Photo® Pro, Corel® VideoStudio®, Corel® WinDVD®, Corel® WordPerfect® Office, WinZip®,
and Corel® Digital Studio” 2010. Our global headquarters are in Ottawa, Canada, and major offices are in
the United States, the United Kingdom, Germany, China, Taiwan, and Japan.

Copyright 2011 Corel Corporation. All rights reserved.
Corel® VideoStudio® Pro X4 Reviewer's Guide
Protected by patents in the United States and elsewhere.

Product specifications, pricing, packaging, technical support and information (“specifications”) refer to the retail English version only.
The specifications for all other versions (including other language versions) may vary.

INFORMATION IS PROVIDED BY COREL ON AN “AS IS” BASIS, WITHOUT ANY OTHER WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABLE QUALITY, SATISFACTORY QUALITY, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE, OR THOSE ARISING BY LAW, STATUTE, USAGE OF TRADE, COURSE OF DEALING OROTHERWISE. THE ENTIRE
RISK AS TO THE RESULTS OF THE INFORMATION PROVIDED OR ITS USE IS ASSUMED BY YOU. COREL SHALL HAVE NO LIABILITY TO YOU
OR ANY OTHER PERSON OR ENTITY FOR ANY INDIRECT, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES WHATSOEVER,
INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE OR PROFIT, LOST OR DAMAGED DATA OR OTHER COMMERCIAL OR ECONOMIC
LOSS, EVEN IF COREL HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR THEY ARE FORESEEABLE. COREL IS ALSO NOT
LIABLE FOR ANY CLAIMS MADE BY ANY THIRD PARTY. COREL'S MAXIMUM AGGREGATE LIABILITY TO YOU SHALL NOT EXCEED THE
COSTS PAID BY YOU TO PURCHASE THE MATERIALS. SOME STATES/COUNTRIES DO NOT ALLOW EXCLUSIONS OR LIMITATIONS OF
LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.

Corel, the Corel logo, CoreIDRAW, Corel DESIGNER, Digital Studio, Painter, PaintShop Photo, VideoStudio, WinDVD, WinZip, and
WordPerfect are trademarks or registered trademarks of Corel Corporation and/or its subsidiaries in Canada, the U.S. and/or other countries.

AMD is a trademark of Advanced Micro Devices, Inc. Apple, FireWire, iPad, iPod, iPod classic, iPod touch, iPhone, iTunes logo, QuickTime and the
QuickTime logo are trademarks or registered trademarks of Apple Computer, Inc., registered in the United States and other countries. QuickTime
and the QuickTime logo are trademarks used under license. AVCHD and the AVCHD logo are trademarks of Panasonic Corporation and Sony
Corporation. Blu-ray, Blu-ray Disc and the Blu-ray Disc logo are trademarks or registered trademarks of the Blu-ray Disc Association used under
license. CUDA, NVIDIA and the NVIDIA logo are trademarks and/or registered trademarks of NVIDIA Corporation in the U.S. and other countries.
Dolby and the double-D logo are trademarks or registered trademarks of Dolby Laboratories. DivX is a trademark of DivX, Inc. and is used under
license. Facebook and the Facebook logo are trademarks or registered trademarks of Facebook Inc. Flash is a trademark or registered trademark
of On2 Technologies Inc. HDV is trademark of Sony Corporation and Victor Company of Japan, Limited (JVC). JVC is a registered trademark of
Victor Company of Japan, Limited. Intel, Core and the Core Inside logo are trademarks of Intel Corporation in the U.S. and other countries.
Microsoft, Windows, Windows Vista, Windows Media and other Microsoft products referenced herein are either trademarks or registered
trademarks of Microsoft Corporation in the United States and/or other countries. PSP and PlayStation Portable are trademarks or registered
trademark of Sony Computer Entertainment Inc. RealVideo is the trademark or registered trademark of RealNetworks, Inc. SmartSound and the
SmartSound logo are trademarks or registered trademarks of SmartSound Software, Inc. Vimeo and the Vimeo logo are trademarks or registered
trademarks of Vimeo LLC. YouTube and the YouTube logo are trademarks or registered trademarks of Google Inc., in the U.S. and other
countries. All other product names and any registered or unregistered trademarks mentioned are used for identification purposes only and
remain the exclusive property of their respective owners.



VideoStudioE(%

Media Contacts

Germany, Austria, Switzerland & Poland:
Tim Schade

Senior PR Manager, EMEA
tim.schade@corel.com

+44 1628 589849

UK, Benelux, Nordics & South Africa:
Chris Boba

EMEA PR Manager
chris.boba@corel.com

+44 1628 589845

France, Italy, Spain, Portugal & Rest of EMEA:
Maria Di Martino

EMEA PR Manager

maria.dimartino@corel.com

+44 1628 589848

Asia Pacific:

Joy Tsai

APAC PR Manager
joy.tsai@corel.com

Tel: +886-2-26273777 ext. 6319

Corel Corporation Corel UK Limited Corel TW Corp.
1600 Carling Ave. Sapphire Court 7F No. 399, Rueiguang Rd,
Ottawa, ON Bell Street Neihu District, Taipei City

Canada K1Z 8R7 Maidenhead 114, Taiwan
Berkshire SL6 1BU
United Kingdom
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